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Parameter Setting Tool 

Parameter Assistant SR23 FP23 

Instruction Manual 

Thank you for choosing this Shimaden product. 

Please read this instruction manual carefully so that you fully understood it before use. 

 



 

 

Introduction 

This manual describes the parameter setting tool Parameter Assistant SR23 FP23.  

 

Target Controllers 

SR23 / FP23 series and SR23A / FP23A series 

 

Related Documents 

• SR23 Series Digital Controllers Instruction Manual (Detailed Edition) Various 

• FP23 Series Program Controllers Instruction Manual (Detailed Edition) Various  

• SR23A Series Digital Controllers Instruction Manual (Detailed Edition) Various  

• FP23A Series Program Controllers Instruction Manual (Detailed Edition) Various 

• Infrared Communication Adapter S5004 Instruction Manual 

• S5004 USB Driver Installation Procedure 

 

 WARNING 

• In order to ensure the safety of your system in the event of a malfunction or failure of this product, or in 

the event of a defect in a program created by the customer, please provide protection and safety circuits 

to ensure sufficient safety measures against personal injury or serious accident.  

 

Handling Precautions 

• Although every effort has been made to ensure the accuracy of this manual, please note that Shimaden 

cannot be held responsible for any damages, including indirect damages, resulting from errors or 

omissions in this manual or from the use of the information. 

• Depending on your environment (system, etc.) and the way you use the application, correct operation may 

not be possible. 

• Please note that Shimaden cannot guarantee the operation of the application on PCs not made by a 

manufacturer (e.g., self-made PCs). 

• Directly modifying the “Save Folder Name”, “Save File”, or “Configuration File” created by this 

application may prevent the application from operating in the intended manner. Please note that Shimaden 

cannot guarantee operation in this case. 
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1 Overview 

“Parameter Assistant SR23 FP23” is a parameter setting tool for setting and managing the parameters of 

SR23/FP23 Series and SR23A/FP23A Series controllers using a Windows PC. 

 

1.1 Function Overview 

This application has the following functions: 

 

1) Reading parameters via communication 

The target controller parameters are read and displayed in the application. 

 

2) Writing parameters via communication 

The parameters set by the application are written to the target controller. 

 

3) Saving/reading parameters 

The parameters set by the application are saved to a data file. The saved file is also read and displayed in 

the application. 

 

4) Displaying parameters 

The related parameters are shown by group. For the FP23/FP23A Series, the program pattern and time 

signal are also displayed in a graph. 

 

5) Print/Print Preview function 

The list of parameters and the “Parameter Settings” window are printed or print previewed. 

 

 

1.2 Operating Environment and Hardware Specifications 

1) Supported operating system: Windows® 10 

• The official name of Windows® is Microsoft® Windows® Operating System. 

• Windows is a registered trademark of Microsoft Corporation in the United States. 

 

2) Communication hardware 

• Hardware that supports RS-232C or RS-485 communication methods 

(When using this hardware, please also refer to the controller instruction manual (Communication 

(Interface)). 

• Infrared communication adapter S5004 

(When using this hardware, please refer to the instruction manual related to S5004.)  
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2 Installation/Uninstallation 

This section explains how to install and uninstall Parameter Assistant SR23 FP23.  

 

2.1 Installation 

1) Download the parameter setting tool Parameter Assistant SR23 FP23 from the Shimaden website 

(http://www.shimaden.co.jp/). 

2) Unzip the downloaded file, then launch setup.exe in the folder that was created. Follow the instructions 

on the screen to proceed. 

 

2.2 Uninstallation 

Method 1: Select “ParameterAssistant_SR23_FP23” from “Applications and Features” in [Start Menu] > 

[Settings] > [Apps], and click the [Uninstall] button. Follow the instructions on the screen to 

proceed. 

 

Method 2: Select “ParameterAssistant_SR23_FP23” from “Uninstall or change a program” in [Start Menu] > 

[Windows System Tools] > [Control Panel] > [Programs] > [Programs and Features], and click the 

“Uninstall” button. Follow the instructions on the screen to proceed. 

 

Note that the following folders and saved files created by this application will not be deleted even after 

uninstalling, so please delete them separately if necessary. 

• C:\Users\[Username]\Documents\Shimaden\ParameterAssistant_SR23_FP23 folder and contents 

• C:\ProgramData\Shimaden\ParameterAssistant_SR23_FP23 folder and contents other than the 

instruction manual files 

(The ProgramData folder will not display if “hidden files” is set to “hide” in Windows.) 

 

 

  

http://www.shimaden.co.jp/
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3 Function Description 

3.1 Names of Window Components 

The names of the window components of the application are shown below. 

 

 

 

 

 

 

Appearance of the application 

 

 

 

 

  

Menu Toolbar 

Tree Parameter Settings window 

Node 
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3.2 Menu 

This section describes the menu functions. 

 

1) [File] menu 

 

 

 

2) [Tool] menu 

 

 

 

 

3) [Help] menu 

 

 

 

4) Menu color settings 

Right-click on “Menu” to display the “Color” dialog box 

shown on the right. In this dialog box, select a color then 

click the “OK” button to apply the color to the menu as 

shown on the next page. Clicking the “Cancel” button 

will close the “Color” dialog box. 

 

  

Display the “Series Selection” dialog box, which is used to create new series.  

Read the parameters saved in a file. 

Save parameters to a file. 

If the file to be saved is not specified, the “Save As” operation is performed.  

Save parameters with a new file name. 

Print a list of parameters. 

Print the “Parameter Settings” window. 

Quit the application. 

Set parameters for communication. 

Read parameters from the controller. 

Write parameters to the controller. 

Write updated parameters to the controller after Comm. READ/WRITE. 

Display the version information. 

Display the “Instruction Manual” PDF data using the software associated with 

PDF files on your computer. When you click “Instruction Manual”, the 

application searches for the “Instruction Manual” PDF file stored at the 

following address. Please copy (replace) the instruction manual PDF file to the 

following address. 

C:\ProgramData\Shimaden\ParameterAssistant_SR23_FP23 
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3.3 Toolbar 

This section describes the functions of the toolbar icons. 

 

Icon, etc. Function 

 

[Menu] > [File] > [New] 

 

[Menu] > [File] > [Open] 

 

[Menu] > [File] > [Save] 

 

[Menu] > [File] > [Print Parameter] 

 

[Menu] > [Tool] > [Comm. READ] 

 

[Menu] > [Tool] > [Comm. WRITE] 

 

[Menu] > [Tool] > [Comm. WRITE Update Value] 

 

Set the width of the application window. 

 

Set the height of the application window. 

 

3.4 Tree/Parameter Settings Window 

Click on a node to display the setting items for the relevant parameter in the “Parameter Settings” window. 

The types of nodes displayed depend on the “Controller Series Name”, “Model Code”, and “Input/Output 

Specifications”. 

 

 

 

  

Node 

The “Controller Series Name” and 

“Input/Output Specifications” are displayed 

in the root name of the node. 

Initial state 

After changing 

the color 
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4 Flow of Operation 

4.1 Start-Up 

Start Parameter Assistant SR23 FP23 from “Parameter Assistant SR23 FP23” shown on the desktop or 

“Shimaden Soft” shown in the start menu. 

 

Parameter Assistant SR23 FP23 icon 

 

4.2 Selecting a Controller Series 

When you start the application, the following “Series Selection” dialog box appears. Select the desired 

controller and click the “OK” button. Clicking the “Cancel” button will close the application. 

 
“Series Selection” dialog box 

 

4.3 Setting Parameters 

When you have selected the desired controller in the “Series Selection” dialog box, the following application 

window appears. Select a node in the tree to switch to the “Parameter Settings” window and set the desired 

parameters. For details, refer to “5. Setting Parameters”. 

 

Application window 

 

  

Tree Parameter Settings window 

Node 
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4.4 Communicating with the Controller 

Use the “Menu” or “Toolbar” icons shown below to perform communication-related operations. For details, 

refer to “6. Communication”. 

         

 

 

 

4.5 Opening/Saving a File 

Use the “Menu” or “Toolbar” icons shown below to perform file operations. 

                  

 

 

 

1) [Open] menu (icon) 

Select “Open” to display the following dialog box. Select the “23p file” save format for the application, then 

click the “Open” button to read the parameters of the “23p file” and reflect them in the application. Clicking 

the “Cancel” button will cancel the “Open” operation. 

 

“Open” dialog box 

 

 

 

 

 

 

  

Menu related to “Communication” Icons related to “Communication” 

Menu related to “File Open/Save” Icons related to “File Open/Save” 

The following address is always displayed during the “Open” operation.  

C:\Users\[Username]\Documents\Shimaden\ParameterAssistant_SR23_FP23 

The “23p” file is displayed. 

The selected “23p” file is displayed. 
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2) [Save] menu (icon) 

The first time you click “Save”, the file name to save the parameter to is not specified, so the operation 

becomes “Save As”. The second and subsequent times you click “Save”, the parameters are saved to the 

specified file name. 

 

 

 

Example of display for a saved file name 

 

3) “Save As” menu. 

Select “Save As” to display the following dialog box. In the “File name” field, a file name created from the 

“Date and time”, “Series name”, and “I/O Specification” is entered as the initial value. Click the “Save” 

button to save the parameters to the file. Clicking the “Cancel” button will cancel the “Save As” operation. 

 

“Save As” dialog box 

 

4.6 Creating a New File 

             

 

 

When you select the menu or toolbar icon shown above, the following “Save Confirmation” dialog box appears 

before the operation to create a new file begins. 

 

“Save confirmation” dialog box that appears before creating a new file 

 

  

The “Address” and “Name” of the saved file are shown in the title bar.  

New menu New icon 

The following address is always displayed during the “Save As” operation.  

C:\Users\[Username]\Documents\Shimaden\ParameterAssistant_SR23_FP23 

If you hover your mouse over the “Don’t Save” button, the 

button shows a warning, alerting you that the parameters will 

be discarded. 
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1) [Save] button 

Click the “Save” button to display the “Save As” dialog box. In the “File name” field, a file name created 

from the “Date and time”, “Series name”, and “I/O Specification” is entered as the initial value. Click the 

“Save” button to save the parameters to a file. The “Series Selection” dialog box for creating a new series 

appears. Clicking the “Cancel” button will close the “Save As” dialog box. 

 

The “Save As” dialog box that appears before creating a new file 

 

2) [Don’t Save] button 

If you click the “Don’t Save” button, the “Series Selection” dialog box for creating a new series will appear. 

The parameters will be discarded, so be careful when performing this operation.  

 

3) [Back] button 

Clicking the “Back” button will cancel the “New” operation. 

 

4) “Series Selection” dialog box for creating new files 

After you have completed the “Save” or “Don’t Save” operations described above, the application window 

you have been using will close. The “Series Selection” dialog box for creating a new series appears as shown 

below (left side). Select the desired controller and click the “OK” button to create a new application window.  

 

In addition, if you check the “Start-up without Initialization” checkbox shown below (right side), you can 

migrate to a new or old version of the same series using the existing parameters (however, model codes that 

cannot be re-used will be left blank, so please set them separately). Note that if you select a different series 

and then try to check “Start-up without Initialization”, the checkbox will not change to the checked state, 

and when you click the “OK” button the parameters will be initialized. 

           

 

 

 

Note that if you check “Start-up without Initialization” without changing the controller series, the 

parameters will not be initialized and will stay the same as they were before the “New” operation.  

“Series Selection” dialog box for creating new files “Start-up without Initialization” checkbox checked  

(Note that this checkbox is ignored when you migrate to  

a different series.) 

The following address is always displayed during the “Save” operation. 

C:\Users\[Username]\Documents\Shimaden\ParameterAssistant_SR23_FP23 
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4.7 Print Parameter/Print Screen 

The following menu and toolbar icons are used for printing operations. Note that if you do not have a printer 

driver installed on your computer, this function cannot be used. 

 

              

 

 

1) [Print Parameter] menu (icon) 

Select “Print Parameter” to display the “Parameter Print Preview” window. 

 

 

 

 

 

 

  

 

 

  

The “Print Parameter” and “Print Screen” menus “Print Parameter” icon 

Previous page Next page 

Page number 

Display the entire preview. 
Adjusts the width of the preview to fit the window width. 

[Print] button* 

“Parameter Print Preview” window “Print” dialog box 

[Print] button* 

Click the “Print” button to display the “Print” dialog box shown 

below. Configure the settings then click the “OK” button. The print 

data is passed to the print driver. Clicking the “Cancel” button will 

cancel the “Print” operation. 

 

For more information on your print driver, please refer to your 

printer manual. 

Print all pages. 

Print a specified range of pages. 

“Date/Time_[Saved File Name] P. Page Number” is shown. 

Note that, if the saved file does not exist, the corresponding part will be shown as [].  
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2) [Print Screen] menu 

Select “Print Screen” to display the “Screen Print Preview” window shown below.  

 

 

 

 

      

 

 

 

 

 

 

 

  

Set the preview scaling factor from 50% to 300%. 

[Print] button 

(See the explanation in “Print Parameter”.) 

Click the “Settings” button to display the “Print Settings” dialog 

box shown below. Configure the parameters then click the 

“Save” button. The settings are reflected in the “Screen Print 

Preview” window and the actual printout. Clicking the “Cancel” 

button discards the changes made to the “Print Setting” 

parameters and closes the dialog box. 

“Screen Print Preview” window 

(The “Parameter Settings” window shown in the 

application is captured and displayed in the “Screen 

Print Preview” window.) 

“Print Settings” dialog box 
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4.8 Quitting 

 

 

 

 

If you click the “Quit” menu item shown above or the application “Close” button, the “Save Confirmation” 

dialog box shown below appears before quitting. 

 

“Save confirmation” dialog box that appears before quitting  

 

1) [Save & Quit] button 

Click the “Save & Quit” button to display the “Save As” dialog box. In the “File name” field, a file name 

created from the “Date and time”, “Series name”, and “I/O Specification” is entered as the initial value. 

Click the “Save” button to save the parameters to a file and quit the application. Clicking the “Cancel” 

button will cancel the “Save & Quit” operation. 

 

“Save As” dialog box 

 

2) [Quit w/o Saving] button 

Clicking the “Quit w/o Saving” button will close the application. The parameters will be discarded, so be 

careful when performing this operation. If you hover your mouse over the button, it shows a warning, 

alerting you that the parameters will be discarded. 

 

3) [Back] button 

Clicking the “Back” button will cancel the “Quit” operation. 

  

“Quit” menu Application “Close” button 

[Close] button 

The following address is always displayed during the “Save & Quit” operation. 

C:\Users\[Username]\Documents\Shimaden\ParameterAssistant_SR23_FP23 

If you hover your mouse over the “Quit w/o Saving” button, 

the button shows a warning, alerting you that the parameters 

will be discarded. 
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5 Setting Parameters 

This section describes the “Parameter Settings” window in the application. Please refer to the instruction 

manual of the relevant controller for each parameter setting item. If you want to set a parameter setting item 

to “OFF”, enter “0”. 

 

5.1 Model Code/Input/Output Specifications 

This window is used to set the “Model Code” and “Input/Output Specifications” of the target controller. Please 

refer to the “Catalog of each controller” or other sources for the setting items. 

 

 

 

 

 

 

 

 

 

 

 

 

  

If there is a supplementary explanation in “10. Special Notes”, 
it is shown here. If you wish to add your own supplementary 

explanations, please use the comment box above. 

Set the Input Specifications. Set the Output Specifications. 

This area is only shown if the output has a “Single/Dual” concept. 

This area is used to change the “Model Code”. Set the same model code as the controller to be communicated with 

to enable communication. 

This area is used to enter a comment such as a description of the parameter value.  

Comments are also reflected in “Parameter Print”. 
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5.2 UNIT/RANGE Window 

 

1) 2in Operation window 

This window only appears when the input Specification is “2in Operation”. It is used to configure the “2in 

Operation” parameters on the controller [UNIT/RANGE] window. 

 

 

 

2) Internal Cascade Control window 

This window only appears when the input Specification is “2in (Internal Cascade)”. It is used to configure 

the “Internal Cascade” parameters on the controller [UNIT/RANGE] window. 

 

 
 

  

This area is shown in “PV mode: DEV”. 

The values cannot be changed. 
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5.3 UNIT/RANGE CH Window 

This window is used to configure the parameters of the controller [UNIT/RANGE] window. 

 

 

 

Range Code SR23／FP23／FP23A SR23A 

Less than 71 OFF (cannot be changed) 

OFF 

PV-MBIAS(PV) 

PV-MBIAS(SV) 

RSV-MBIAS(SV) 

(Only shown when “HB Alarm” is not selected in the 

model code) 

71 or higher 

OFF OFF 

ON 

Linearizer 

PV-MBIAS(PV) 

PV-MBIAS(SV) 

RSV-MBIAS(SV) 

(Only shown when “HB Alarm” is not selected in the 

model code) 

 

  

This area is enabled when the “Range” code is 71 or higher. 
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5.4 SV Window 

 

1) In the case of SR23/SR23A Series 

This window is used to configure the [SV] parameters of the controller [SV] window. 

 

 

 

 

2) In the case of FP23/FP23A Series 

This window is used to configure the [SV Limit] parameters of the controller [LOCK] window. 

 

 

 

 

 

 

  

“Model Code 5” is enabled when the “Remote Setting Input” 

item is selected, and disabled when the “HB Alarm” item is 

selected. 
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5.5 Zone PID/Auto Tuning Window 

This window is used to configure the [Zone PID/Auto Tuning] parameters of the controller [PID] window.  

 

 

 

[Auto Tuning] 

1) SR23/SR23A Series: Non-servo 

1in, 2in Operation/ Output Specification: Single 1in, 2in Operation/ Output Specification: Dual 

   

 

Internal Cascade Independent 2channel 

   

 

2) SR23/SR23A Series: Servo 

Servo feedback: ON Servo feedback: OFF 

   

 

3) FP23 / FP23A Series 

1in, 2in Operation Independent 2channel 

   

 

  

Fixed with Auto 

Fixed with Auto 

Fixed with Auto 
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5.6 PID1 to 10 Window 

This window is used to configure the [PID 1 to 10] parameters of the controller [PID] window. 

 

 

 

 

 

 

 

  



19 

 

5.7 EV1 to DO13 Window 

This window is used to configure the parameters of the controller [EVENT/DO] window.  

 

 

 

5.8 DI/OPTION Window 

This window is used to configure the parameters of the controller [DI/OPTION] window.  

 

 

 

  

The DI assignment is 

shown such that no 

duplicate selection 

can be made except 

for None and LOGIC. 

This area is enabled when the model code “6, 7. Analog Output” is selected.  

This area is enabled when model code “5. HB Alarm” is selected. 

Only shown for SR23A and FP23A. 

Only shown for FP23A. 

These areas are enabled when the operation mode is LOGIC. 

The “DO count” in the model code “8. External I/O Control 

Signals (DI/DO)” is reflected in the number of nodes shown.  
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5.9 Servo Operation Settings Screen 

This window is shown when model code “2. Basic Functions” is set to “Servo”, and is used to configure the 

“servo-related” parameters on the controller [CTRL OUT] window. 

 

 

 

5.10 CTRL OUT Window 

This window is used to configure the “output related” parameters of the controller [CTRL OUT] window.  

 

 

1) Non-servo 

 

 

 

2) Servo 

 

 

 

  

Model code “2. Basic Functions” differs depending on whether the controller is “Non-servo/Servo”. 

[SR23 / SR23A Series] 

[FP23 / FP23A Series] 

[SR23 / SR23A Series] 

[FP23 / FP23A Series] 
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5.11 LOCK Window 

This window is used to configure the [KLOCK] parameters of the controller [LOCK] window.  

 

 
 

 

5.12 FIX MODE Window (only shown for FP23/FP23A Series) 

This window is used to configure the “FIX related” parameters of the controller [CTRL EXEC] window.  

 

 

 

 

 

 

 

  

Shown when the “FIX SV value” is “Outside the SV  

limiter range” 
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5.13 Batch Settings Window (only shown for FP23/FP23A Series) 

 

1) Step Count Display 

This area is used to batch set the “Step Count” in the application window [PROGRAM] > [CH*] > [PTN_**]. 

 

2) Time Chart Comment 

This area is used to batch set comments in the application window [PROGRAM] > [CH*] > [PTN_**] > 

[Time Chart]. 

 

 

 

 

 

 

 

  

*: Indicates an arbitrary single character. 
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5.14 Pattern-Related Parameters Window (only shown for FP23/FP23A Series) 

This window is used to configure the pattern-related parameters of the controller [LOCK] and [CTRL EXEC] 

windows. 

 

 

 

 

 

 

 

 

  

The window of the corresponding controller is shown in the title of each group box. 
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5.15 Pattern-Related Settings Window (only shown for FP23/FP23A Series) 

This window is used to configure the non-time signal parameters of the controller [PROGRAM] window. 

 

 

 

 

 

 

 

 

 

 

 

 

Copy menu 

 

 

 

  

This value is also reflected in the graph on the STEP screen. 

Display the Settings window. 

Display the STEP window. 

(After the window appears, this button changes to the STEP window/TIME window switching button.) 

Display the Time Signal window. 

How to operate the “Settings”, “STEP” and “Time Signal” buttons 

• Left click : Apply only to the corresponding PTN node 

• Right-click : Batch apply to all PTN nodes 

Right-click on the selected PTN node to display the following menu. 

You can copy and paste PTN parameters. 

After copying, the “Paste” menu changes to “Paste (PTN**_CH*)” and the 
information that was copied is added. 

You can “Save to File” and “Open from File” for PTN parameters.  

A detailed explanation is provided on the next page. 

Reset the PTN parameters to their initial state. 

*: Indicates an arbitrary single character. 
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1) [Save to File] menu 

Select the “Save to File” menu to display the “Save to File” dialog box. In the “File name” field, a file name 

created from the “Date and time”, “PTN name”, and “CH name” is entered as the initial value. Click the 

“Save” button to save the PTN parameters to the file. Clicking the “Cancel” button will cancel the “Save to 

File” operation. 

 

“Save to File” dialog box 

 

2) [Open from File] menu 

Select “Open from File” to display the dialog box shown below. Select the PTN parameter saving format 

“csv file” and click the “Open” button to apply the parameters read from the “csv file” to the selected PTN. 

Clicking the “Cancel” button will cancel the “Open from File” operation. 

 

 

“Open from File” dialog box 

 

 

 

  

The following address is always displayed during the “Save to File” operation.  

C:\Users\[Username]\Documents\Shimaden\ParameterAssistant_SR23_FP23 

The following address is always displayed during the “Open from File” operation. 

C:\Users\[Username]\Documents\Shimaden\ParameterAssistant_SR23_FP23 
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5.16 STEP Window (only shown for FP23/FP23A Series) 

This window is used to configure the parameters of the controller [STEP] window. The graph shows “STEP 

vs SV”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

[Overall graph] 

Left mouse click: Set the display position on the enlarged graph. 

[Enlarged graph] 

Mouse wheel: Scroll the display. 

If the value is 00:02 or higher, it is shown in color. 

If the value is 0.001 or higher, it is shown in color. 

SV limit range 

Out of SV limit range 

Out of SV limit range 

If the value is outside the SV limit range, it is shown in color.  

The Time values are calculated by entering the 

dSV/dt values. The dSV/dt values are then 

recalculated using the Time values. 

The entered values may change due to the effect of 

fractions in the recalculation. 

[Plot points of SV values] 

The following input methods can be used to set the SV value: 

a. Enter numerical values into the text boxes 

b. Click and drag on the graph using the left mouse button 

c. Fine tune using the mouse wheel or arrow keys 

(You can adjust the amount of change by holding down 

the Shift or Ctrl key) 

 

To start method c, click the right mouse button on the graph 

to change the SV value plot point from red to black. 

To exit, click the right mouse button on the graph again to 

change the SV value plot point back to red. 
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5.17 TIME Window (only shown for FP23/FP23A Series) 

This window is used to show the STEP window graph as “Time vs SV”. 

 

 

 

 

 

 

 

 

 

 

 

  

[How to use the overall graph] 

Left mouse click : Set the display position on the enlarged graph. 

Right mouse click : Set the display width on the enlarged graph. 

Comments are shown here. They are 

reflected in “Screen Print” and 

“PROGRAM Window”. 

Adjust the spacing of the horizontal axis here. 

You can configure the upper and lower graphs 

independently. 

Overall graph 

Enlarged graph 
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5.18 Time Signal Window (only shown for FP23/FP23A Series) 

This window is used to configure the “Time Signal (TS1 to 8) Related” parameters of the controller 

[PROGRAM] window. 

 

 

 

 

 

 

 

 

 

 

  

Enter values in the text boxes, and they are reflected in the graph on the right.  

The time signal calculated from the input parameters is plotted. 
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6 Communication 

This section describes the communication method. For more information on how to connect the controller and 

the PC (host computer), refer to the relevant controller’s instruction manual.  

 

6.1 Comm. Settings 

Select “Comm. Settings” to display the following “Comm. Settings” dialog box. Set the parameters here to 

match the controller (must be a communication-compatible controller) to enable communication. The setting 

range is as shown in the table below. 

 
“Comm. Settings” dialog box 

 

Group name Item Setting range 

Port settings 

Port number 
(When configuring the “port number”, select the “COM number” shown in the 
driver item for “Your Communication Hardware” shown in “Ports (COM & 

LPT)” in “Device Manager” on your PC.) 

COM1 to 10 

Communication speed [bps] 2400, 4800, 9600, 19200 

Data length [bit] 7, 8 

Parity EVEN, ODD, NONE 

Stop bit [bit] 1, 2 

Communication 

Settings 

Protocol SHIMADEN 

Address 01 to 98 

Control code STX_EXT_CR 

BCC calculation method ADD 

Timeout [ms] 
(The timeout value is a special parameter for this application. It is used to 

generate a timeout error after a set period of time has elapsed if there is no 

response from the controller.) 

1000, 2000 

 

1) [Initialization] button 

This button is used to reset each of the “Port Settings/Communication Settings” parameters to their initial 

values. 

 

2) [Save Settings] button 

This button is used to save the parameter settings and close the dialog box. The saved values are used in the 

next operation and the next time the application is started. 

 

3) [Cancel] button 

This button is used to discard the parameter changes and close the dialog box.  
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6.2 Comm. READ 

Select “Comm. READ” to display the “Comm. READ dialog box” shown below. Each of the displayed “Port 

Settings/Communication Settings” parameters is set to the value that was most recently saved. Also, each 

parameter is saved when you click the “Read” button. 

 
Comm. READ dialog box 

 

1) [Initialization] button 

This button is used to reset each of the “Port Settings/Communication Settings” parameters to their initial 

values. 

 

2) [Read] button 

This button reads the parameters of the connected controller and applies them to the application parameters. 

When Comm. READ is completed, the dialog box shown below (right side) appears. Click the “OK” button 

to exit. 

       
 

 

3) [Cancel] button 

Clicking the “Cancel” button will cancel the “Comm. READ” operation and close the dialog box. 

 

 

  

Comm. READ in progress window Dialog box on completion of Comm. READ 
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6.3 Comm. WRITE 

Select “Comm. WRITE” to display the following “Comm. WRITE” dialog box. Each of the displayed “Port 

Settings/Communication Settings/Communication Parameters” parameters are set to the value that was most 

recently saved. Also, each parameter is saved when you click the “Write” button. 

 
 

 

1) [Initialization] button 

This button is used to reset each of the “Port Settings/Communication Settings” parameters to their initial 

values. 

 

2) [Write] button 

The application parameters are written to the connected controller. When Comm. WRITE is completed, the 

dialog box shown below (right side) appears. Click the “OK” button to exit. 

       
 

 

3) [Cancel] button 

Clicking the “Cancel” button will cancel the “Comm. WRITE” operation and close the dialog box. 

 

 

  

Group name Item Setting range 

Communication 

parameter 

STBY (CH1) 
OFF, ON 

STBY (CH2) 

COM Mode LOCAL, COM 

Comm. WRITE in progress window Dialog box on completion of Comm. WRITE 

Check Box 

Only shown for SR23/SR23A 

Series 

Comm. Write dialog box 

Setting range for communication parameters 

[STBY (CH*)] 

After communication is completed, this parameter sets the 

controller's STBY parameter. 

[COM Mode] 

After communication is completed, this parameter sets the 

controller's COM parameter. 

[Check Box] 

Checking this checkbox enables the setting changes and 

communication for the corresponding parameters. 

*: Indicates an arbitrary single character. 
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6.4 Comm. WRITE Update Value 

Select “Comm. WRITE Update Value” to display the following “Comm. WRITE Update Value” dialog box. 

Each of the displayed “Port Settings/Communication Settings/Communication Parameters” parameters are set 

to the value that was most recently saved. Also, each parameter is saved when you click the “Write” button.  

 

 
Comm. WRITE Update Value dialog box 

 

1) [Initialization] button 

This button is used to reset each of the “Port Settings/Communication Settings” parameters to their initial 

values. 

 

2) [Write] button 

Of the parameters that were written using “Comm. READ/WRITE” before this operation, only the updated 

parameters are written to the connected controller. When Comm. WRITE is completed, the dialog box shown 

below (right side) appears. Click the “OK” button to exit. 

        
 

 

 

3) [Cancel] button 

Clicking the “Cancel” button will cancel the “Comm. WRITE Update Value” operation and close the dialog 

box. 

 

  

For details of this function, refer to “Comm. WRITE”. 

Comm. WRITE Update Value in progress window Dialog box on completion of  

Comm. WRITE Update Value 
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6.5 Communication Errors 

 

1) Communication connection failure error 

If the communication connection fails due to reasons such as the controller and PC not being physically 

connected or the application communication settings being different from those of the controller, the 

following error message is displayed and the communication operation terminates.  

 

Error message when communication connection fails 

 

2) Mismatch error in “Model Code” or “Input Specifications” 

If there is a mismatch in the “Model Code” or “Input Specifications” between the connected controller and 

the application during “Comm. WRITE” or “Comm. WRITE Update Value”, the following error message is 

displayed. In order to communicate, it is necessary to resolve the mismatch according to the error message.  

 

Error message when there is a mismatch in the “Model Code” or “Input Specifications”  

 

3) Errors received from the controller 

If the application receives an error from the controller, the following error message is displayed and the 

communication operation terminates. For more details about response codes, please refer to the controller 

instruction manual (Communication (Interface)). 

 

 
Example of “Error received from controller” 

 

 

  

Error code: 

Response code received from the controller 

Data address: 

Data address when an error occurs 

Request message sent to the 

controller when the error occurred 
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4) “Timeout” error 

When the application sends a request message to the controller, if no response message is received after the 

time set in the “Timeout” application parameter, the following error message is displayed.  

 

 

“Timeout” error message 

 

5) Communication cable disconnected during communication” error 

If the communication cable is disconnected during communication, the error shown below (left side) is 

displayed and the communication operation terminates. If you reconnect the communication cable after this 

error and try to communicate with the controller without restarting the application, the error shown below 

(right side) is displayed and the communication operation will not start. If this error occurs, save the data as 

necessary and restart the application. 

 

    

 

 

 

 

 

 

“Communication cable disconnected during 

communication” error message 

Error message when communication is attempted 

after “Communication cable disconnected during 

communication” error without restarting 
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